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1 Introduction

DropDMG is a utility for creating disk images in Mac OS X’s .dmg format. Disk images are
a wonderful way of packing entire folders or disks into a single file, either for transport across
the Internet or simply for archival. They are Apple’s preferred format for distributing Mac
OS X software. Unlike other formats, disk images preserve both long filenames and Mac
and Unix metadata. Their contents may be accessed using the Disk Copy application that’s
included with Mac OS X. Although Disk Copy can also create disk images, DropDMG is
more powerful and easier to use.

Here’s a brief rundown of DropDMG’s features:

• Create compressed, read-only, and read-write .dmg images, as well as .img and .smi

(self-mounting) images that work on Mac OS 9.

• Segment images, encrypt them, and encode them with BZip2, GZip, or MacBinary.

• Include rich text license agreements, in multiple languages.

• Make images that auto-open when you mount them. Or make Internet-enabled1 images
that expand into a folder when you double-click them.

• Convert images between different formats.

• Hold down Option when creating an image to specify options for that image without
changing the preferences.

• All options are available from AppleScript.

• Create more than one image at a time to take advantage of dual processors, or just so
you don’t have to babysit the program when creating multiple images.

• Fix downloaded disk images so that they open in Disk Copy.

• Reliability. Like all good Mac applications, DropDMG has no trouble handling files
with spaces, quotation marks, dollar signs, or other “special” characters.

2 Setting Up DropDMG

2.1 Requirements

DropDMG has been developed and tested on Mac OS X 10.1.5 and 10.2.5. I do not have
the resources to test it on other systems, although it should work fine on Mac OS X 10.1 or
later. DropDMG does not require Mac OS X’s optional “BSD Subsystem” installation.

1http://developer.apple.com/ue/files/iedi.html
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2.2 Installation

Double-click the DropDMG-2.1.dmg file. If you are using Mac OS X 10.2.3 or later, the
DropDMG application and manual will be copied to your hard disk automatically. You can
then install them wherever you want, e.g. into /Applications/Utilities. If you are using
an older version of Mac OS X 10.2, you will need to copy the DropDMG application from
the disk image to your hard disk.

There’s no need to copy this manual to your hard disk. A copy of it is built into
DropDMG, and you can access it by choosing DropDMG Manual (PDF) from the Help
menu. Apple Help is also available by choosing DropDMG Help from the Help menu.

2.3 Updating From DropDMG 1.x–2.0

DropDMG 2.1 is a free update for registered users of previous versions of DropDMG. Simply
replace your old copy of the DropDMG application with the new version. DropDMG 2.1
will not recognize serial numbers from DropDMG 1.x. If you registered DropDMG 1.x, you
should have received an e-mail explaining how to get a new serial number. If you did not
receive this e-mail, please contact dropdmg@c-command.com2.

3 Basic Operations

3.1 The Status Window

The top portion of the DropDMG Status window displays the current options that will
be used for creating images. The options may be changed using the Preferences window
(Section 6). You can also Control-click on the striped portion of the window to quickly
change common preferences using a contextual menu.

The bottom portion of the status window displays a log of the images that DropDMG has
created, converted, and fixed. Choose Clear Log from the File menu to erase the contents
of the log.

3.2 Creating Disk Images

There are several ways to create disk images using DropDMG:

Drag and Drop Drag and drop one or more folders onto the DropDMG icon, either in the
Finder or in the Dock; or onto the top portion of the status window.

Menu Choose New Image from Folder or Volume. . . from the File menu.

AppleScript You can use AppleScript to automate the creation of an image. For example:

tell application "DropDMG"
create image from folder "~/Desktop/image.dmg" format NDIF compressed

end tell

2mailto:dropdmg@c-command.com
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Command-Line To create disk images using the options specified in the preferences, you
can use open and pass the folders as arguments:

open -a DropDMG.app ~/path/to/a/folder ~/another/folder

If you want to specify options from the command line, use osascript to run an Ap-
pleScript.

osascript -e ’tell app "DropDMG" to create image \

from folder "~/Documents" \

destination "~/Desktop" \

format self mounting encoding macbinary’

Note: Dragging a volume onto DropDMG creates an image that contains the volume’s
contents, not an image of the device. Use Disk Copy to create images of devices, e.g. to make
an image of a bootable CD-ROM.

3.3 Converting Disk Images

DropDMG can convert existing disk images to the format specified in the preferences. You
can use conversion to change a Mac OS X image into a Mac OS 9 image, to add or remove a
license agreement, to add or remove encryption, to segment an existing image or join multiple
segment files into one image, to change an image’s compression, or any nearly combination
of the above.

There are several ways to convert disk images using DropDMG:

Drag and Drop Drag and drop one or more image files onto the DropDMG icon, either in
the Finder or in the Dock; or onto the top portion of the status window.

Menu Choose Convert Image. . . from the File menu.

AppleScript You can use AppleScript to automate the conversion of an image. For exam-
ple:

tell application "DropDMG"
set myImage to "~/Desktop/image.dmg"
create image by converting image myImage format NDIF compressed

end tell

Command-Line Use osascript to convert the image using DropDMG’s AppleScript in-
terface.

osascript -e ’tell app "DropDMG" to create image \

by converting image "~/Desktop/image.dmg"’
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3.4 Fixing Disk Images

Sometimes a downloaded disk image won’t open in Disk Copy because the Web server told
the Web browser that the disk image was a text file. DropDMG can fix such images by
setting their type and creator codes so that the Finder will open them in Disk Copy. There
are two ways to fix disk images:

• Drag and drop one or more disk images onto the DropDMG icon or onto the DropDMG
Status window while holding down the Control key.

• Choose Fix Disk Image. . . from the File menu.

3.5 Making Images With Background Pictures

When making an image from a folder, DropDMG copies to the image the background pictures
and view options of all the contained folders. It does not copy this information for the top-
level folder because Apple does not provide a way to do this. If the top-level background
picture and view settings on the image are important to you, you can set them as follows:

1. Drag the folder onto DropDMG and create a read-write image.

2. Mount the image in the Finder.

3. Set the background picture on the mounted image. Make sure the picture file you
select is saved somewhere on the disk image. Set the view options and arrange the
icons the way you want them.

4. Sometimes the Finder doesn’t save changes to the view options. It may help to create
and delete an empty folder on the image.

5. Unmount the image in the Finder.

6. Drag the image onto DropDMG and convert it to read-only or a compressed format.

4 License Agreements

Disk images can include license agreements, which are displayed to the user whenever Disk
Copy mounts the image. DropDMG lets you define multiple license agreements ahead of
time. Each agreement may be localized into multiple languages. You can choose which
agreement (if any) to include with an image. When you make an image, DropDMG will add
that agreement, and all its localizations, to the image file.

To manage your license agreements, choose Show Agreements from the License
Agreements menu. This opens the License Agreements window, which displays the
agreements and localizations you have defined. The license agreements are automatically
saved in DropDMG’s preferences file.

To make a new license agreement, choose Add Agreement. . . from the License Agree-
ments menu. The created agreement will be empty. You can rename it by double-clicking
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the agreement’s name. In order to type the text of the agreement, use Add Language. . .
from the License Agreements menu. This creates an entry in the License Agreements
window for a new localized variant. Note that only the English variant will be displayed on
Mac OS 9.

To edit the text of an agreement, double-click on one of its languages in the License
Agreements window. This opens an editing window where you can type. You can view
and edit multiple localizations at once, if you want. The Edit menu contains commands for
checking spelling and text-to-speech.

Use the Delete Selection command in the License Agreements menu to delete the
selected agreement or localization.

License agreements can use multiple fonts, sizes, and styles of text. Beware, however, of
using fonts that are not built into Mac OS X, for the license agreement will look different
if the user does not have the fonts installed. Secondly, note that “synthetic” font traits will
not be preserved between DropDMG and Disk Copy. A synthetic trait is a style for which
you do not have a font. For instance, Mac OS X ships with normal and bold variants of
Lucida. Both of these work fine in license agreements. DropDMG will also let you create
a license agreement using italic Lucida, where the operating synthesizes Lucida Italic from
regular Lucida, but the italic style will not be displayed in Disk Copy.

5 Overriding the Preferences

Normally, when DropDMG is creating or converting an image, it uses the preferences shown
in the Preferences window. (See Section 6 for explanations of the preferences.) Sometimes
you may wish to use slightly different preferences for a particular image. For instance,
perhaps you usually create .dmg images, but you sometimes need to make .img images for
a friend who uses Mac OS 9. You could open the Preferences window, change the image
format to .img, make the image, and change the format back to .dmg. Or, you could save
yourself some time by overriding the preferences.

To use override the preferences, hold down the Option key when you drag a folder or
image onto DropDMG’s icon or the DropDMG Status window. That is, click on the
icon and begin dragging; then hold the Option key before you release the mouse button.
After releasing the mouse button, continue holding down Option until DropDMG displays
a preferences sheet with the name of your folder at the top. Any changes you make in this
sheet will only affect that folder; they will not be saved. Click the OK button to use the
preferences as shown, or the Cancel button to not create the image after all.

If you drop more than one item onto DropDMG, continue holding Option until a window
and sheet have opened for each item. With more than one preferences sheet open, you can
use the Copy to Others button to copy the settings on one sheet to the other sheets. In
this way, you can quickly override the preferences to create many similar images.
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6 Preferences

6.1 Image Format

DropDMG supports the following image formats:

.dmg zlib-compressed zlib creates the smallest disk images, but they only work on Mac
OS X 10.1 and later. This is DropDMG’s recommended format for general use. zlib
images created on Mac OS X 10.2 or later will be smaller than those created on 10.1.x.
The smaller images are fully compatible with 10.1.x.

.dmg ADC-compressed ADC images are a bit larger and slower than zlib images, but
they work on all versions of Mac OS X.

.dmg Read-only Read-only images require Mac OS X and are larger than zlib- and ADC-
compressed images. However, when post-compressed with BZip2 or GZip they may
end up smaller than the other formats. Read-only images are also a good choice when
the folder you are imaging contains internally compressed files such as MP3s or JPEGs;
in this case, using a compressed image format takes significantly longer and does not
save much more space.

.dmg Read-write Read-write images can be mounted in the Finder and their contents
modified. DropDMG creates read-write images slightly larger than needed to hold all
the files. This allows you to make minor modifications such as repositioning icons and
creating aliases to other files on the image. Once the image is exactly the way you
want it, you can use DropDMG to convert the read-write image into a compressed one.
Another use for read-write images is as a secure workspace. If you turn on encryption,
you can read and edit the files on the image as normal. However, when you unmount
the image, no one will be able to access the images without the password.

.img NDIF-compressed NDIF images work with Disk Copy 6.x on Mac OS 7, 8, and 9,
as well as on Mac OS X. They have resource forks and so must be encoded with a
utility such as StuffIt, MacBinary, or BinHex before they are shared on the Internet.
NDIF images do not support encryption and they are limited to 2 GB.

.smi NDIF-compressed Self-mounting NDIF images (.smi files) may be used on Mac OS
7, 8, and 9 systems that do not have Disk Copy installed. Additionally, self-mounting
images are the only type that can display license agreements on Mac OS 9.

6.2 Encrypted

Encrypted images require a password for access. They work on Mac OS X 10.1 and later.
Encrypted images are much slower to access than unencrypted images. DropDMG uses
Apple’s implementation of the AES-128 algorithm3.

3http://csrc.nist.gov/encryption/aes/
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6.3 Limit segments to MB

This option lets you set a maximum size for image files. If an image requires more space
than the set limit, DropDMG will split the image into two or more files.

6.4 Encoding

If you choose an encoding other than None, DropDMG will encode images so that you end
up with a .bz2 file, a .gz file, or a .bin file. If you select BZip2 or GZip, the image will be
compressed a second time, in addition to the zlib/ADC/NDIF compression that is intrinsic
to the image format. This will make the resulting file a bit smaller.

Some Web servers have trouble handling plain .dmg files, so that when people download
them they open in the Web browser instead of Disk Copy. Using encoding eliminates this
problem, at the expense of an extra decompression step after downloading (usually using
StuffIt Expander or OpenUp).

BZip2 is slower than GZip but compresses better. MacBinary offers no compression at
all, so it is fast. DropDMG can only compress with BZip2 when running on Mac OS X 10.2
or later. BZip2 and GZip are disabled for NDIF images because they do not work with files
that have resource forks.

If you use encoding in combination with segments, DropDMG will encode each segment
of the image. Some segments may compress better than others, so it is normal for the
segments to be of unequal size after encoding.

NDIF image files cannot be directly transmitted on the Internet because they have re-
source forks. MacBinary encoding converts the image to a data fork–only file that can be
safely uploaded to Web and FTP servers, even using software that’s improperly configured
or not Mac-savvy.

6.5 License Agreement

If you choose a license agreement other than None, Disk Copy will display a license agree-
ment each time the image is mounted. Use the pop-up menu to select the license agreement
you want included. This option is disabled if you have not entered any license agreements.
To add a license agreement, choose Show Agreements from the License Agreements
menu. Then choose Add Agreement. . . to add an agreement and Add Language. . . to
add at least one language.

6.6 Auto-open image window after mounting

With this option selected, DropDMG will make images that automatically open their root
folder when mounted. That is, when you double-click the image in the Finder, its window
will open. This is especially useful for images that you will be distributing to other users.
Depending on how their Finders are configured, they may not see the image’s icon appear
on the desktop; therefore, making the image window auto-open provides a superior user
experience.

9



6.7 Internet-enabled (auto-copy instead of mounting)

An Internet-enabled4 disk image automatically expands itself into a folder when you double-
click it. The image file is moved to the trash. On Mac OS X 10.2.2 and earlier, an Internet-
enabled image behaves like a normal image.

6.8 Save Images

You can choose to have images created in the same folder as the source folder (Next to
Source), or specify a folder where images should be saved (Other. . .). If you specify a
destination folder that’s contained by the source folder, DropDMG will revert to its default
behavior of saving the image next to the source folder.

The bottom portion of the pop-up menu lists recent folders and favorite folders. Recent
folders are the last 10 folders that you’ve chosen. Favorite folders are always shown in the
menu, even if you have not used them recently. To make a recent folder into a favorite folder,
find the folder’s alias in ~/Library/Application Support/DropDMG/Recent Folders. Se-
lect the alias and open the Finder’s Get Info window. Then click the Locked checkbox.

6.9 Prompt for image and volume names

With this option selected, DropDMG will ask you to enter the name of the image file it
will create and the name of the volume that will appear on the desktop when you mount
the image. DropDMG will automatically add the proper filename extension (.dmg, .img, or
.smi) to the image name. It may also truncate the names you enter if they would be too
long for the Mac’s volume and filename limits.

With this option deselected, DropDMG will assign the image and volume names based
on the name of the folder being imaged.

6.10 Delete original after Creating or Converting

If you select one of these options, DropDMG will move the source folder or image to the
trash after it has finished making the image.

6.11 When Imaging a Package

Some Mac OS X files, such as a applications, are actually special folders called packages.
The system presents packages to the user as a single file, but they’re actually stored on disk
as folders. Normally, when DropDMG makes an image from a folder it copies the contents
of the folder into the image; that is, the mounted image behaves just like the original folder
did.

Since packages are folders, you can make images of them with DropDMG. However, if
DropDMG proceeds as usual, when you mount an image that was created from a package,
the Finder will think that the mounted image is a package. It will show the package icon

4http://developer.apple.com/ue/files/iedi.html
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instead of the disk image icon, but it won’t let you double-click the mounted image to access
the package (e.g. launch the application). You might think that you could drag the mounted
image to your hard disk to launch the application from there, but the Finder will create an
alias instead (unless you know to hold down Option).

Therefore, by default, DropDMG recognizes when you are imaging a package and gives
you a disk image with the package inside it, instead of making an image of the package. To
disable this feature, and thus have DropDMG treat all folders consistently, click the Copy
contents of package radio button.

7 AppleScripting DropDMG

AppleScript5 is a great way to automate your Mac. You can view DropDMG’s AppleScript
dictionary by dragging and dropping the DropDMG application onto Apple’s Script Editor.
The create image command lets you make images from folders or other images. Whenever
you use create image, you must always include one of the following parameters (but not
both):

from folder This can be a POSIX path or an alias to a folder.

by converting image This can be a POSIX path or an alias to a disk image file.

The remaining parameters are optional.

format This corresponds to the preference in Section 6.1. Accepted values are: zlib

compressed, ADC compressed, read only, read write, NDIF compressed, and self

mounting. If no format is specified, DropDMG will choose zlib compressed.

encryption This corresponds to the preference in Section 6.2. It should be either true or
false. If no value is specified, DropDMG will make the image unencrypted.

segment size This corresponds to the preference in Section 6.3. It should be a number,
zero or greater, representing the number of megabytes per segment. If the value is zero
or omitted, DropDMG will not segment the image.

encoding This corresponds to the preference in Section 6.4. Accepted values are: none,
bzip2, gzip, and macbinary. If no encoding is specified, DropDMG will choose none.

license agreement name This corresponds to the preference in Section 6.5. If the name
is omitted or the empty string (""), DropDMG will not include a license agreement.

auto open This corresponds to the preference in Section 6.6. It should be either true or
false. If no value is specified, DropDMG will make the image auto-open. This option
is ignored when creating an image by converting.

5http://www.apple.com/applescript/
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internet enabled This corresponds to the preference in Section 6.7. It should be either
true or false. If no value is specified, the image will not be Internet-enabled.

destination This corresponds to the preference in Section 6.8. This can be a POSIX path
or an alias to a folder. If the destination is omitted or the empty string (""), DropDMG
will use the folder that contains the source folder or image.

base name This is the name of the image to create, without the .dmg, .img, or .smi

extension. If the base name is omitted or the empty string (""), DropDMG will use
the name of the source folder or image.

volume name This is the name of the mounted image volume. If the volume name is
ommitted or the empty string (""), DropDMG will use the name of the source folder.
This option is ignored when creating an image by converting.

delete original This corresponds to the preference in Section 6.10. It should be either true
or false. If no value is specified, DropDMG will not delete the source folder or image.

just package contents This corresponds to the preference in Section 6.11. It should be
either true or false. If no value is specified, DropDMG will copy the package. This
option is ignored when creating an image by converting.

returning immediately If this is true, the script will tell DropDMG to create the image
and then immediately resume with the next command in the script. If it is false

(the default), AppleScript will wait until DropDMG has finished creating the image
before resuming the script. In this latter case, you may wish to use AppleScript’s with
timeout construct when creating large images to prevent AppleScript from “giving up”
if creating the image takes a long time. In addition, the DropDMG application will be
unresponsive (though any operations already in progress will proceed and complete as
normal) until the create image command has returned.

8 Contact Information

You can download the latest version of DropDMG from the DropDMG Web site6. Questions
about DropDMG may be sent to dropdmg@c- command.com7. I’m always looking to improve
DropDMG, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of DropDMG, you may wish to subscribe
to the DropDMG Announcements mailing list8. The traffic on this list is very low, only one
message per new version of DropDMG.

6http://www.c-command.com/dropdmg/
7mailto:dropdmg@c-command.com
8http://www.c-command.com/dropdmg/support.shtml
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9 Registering

DropDMG is free to try, but if you find yourself using DropDMG beyond a reasonable trial
period, you must register it. Registration costs $10 (US) and entitles you to free updates
and support.

This is the honor system. If you use DropDMG without registering, I probably won’t
know. However, registering will give me an incentive to continue updating and enhancing
DropDMG, and to write more Mac software. And you won’t have to look at the shareware
reminders anymore.

To register, choose Registration. . . from the DropDMG menu. You can use the In-
stant Registration. . . button to enter your billing information from within DropDMG or
use the Web Registration. . . button to enter it at the eSellerate Online Store9 in your Web
browser.

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name
and serial number from the e-mail into the Registration window and click Personalize
to personalize your copy of DropDMG. If you need to re-install DropDMG, you can simply
re-enter your name and serial number and click Personalize; there’s no need to register
again.

A license for DropDMG is good for one person or one computer. You can install it on
one Mac, and everyone sharing that Mac can use it (on that Mac). Alternatively, you can
install it on your desktop Mac and your PowerBook; you can then use it on either machine,
provided that no one is using it on the other machine.

DropDMG uses eSellerate Product Activation10 to reduce software piracy. This should
be completely transparent except that you will need to be connected to the Internet when
you first enter DropDMG’s serial number. (Subsequent launches do not require an Internet
connection.) eSellerate’s privacy policy is as follows:

eSellerate Product Activation is an anti-piracy technology that publishers can
use to protect the software they sell through eSellerate.

During activation, eSellerate looks at the computer’s present configuration
and uses that data to create a unique hardware identification. The unique hard-
ware identification does not include any personal information, nor does it include
any information about the software or documents that reside on the computer.
The hardware identification identifies only the computer’s configuration, and is
used only for activation purposes.

Once software is activated on a computer, minor changes to that computer’s
configuration will not affect the activation. Major changes to the computer’s
configuration may require reactivation of the software. Reactivation is at the
publisher’s discretion.

Registering DropDMG entitles you to a reasonable number of activations. You can
activate DropDMG on your desktop, on your laptop, and on new Macs that you buy in the

9http://store.eSellerate.net/mt/store
10http://www.esellerate.net/papolicy.asp
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coming years. If you run out of activations, e-mail me and I’ll most likely give you more.
The goal is to make things as easy as possible for registered users of DropDMG.

10 Version History

2.1—April 24, 2003

• Remembers recent and favorite destination folders.

• Can create Internet-enabled disk images.

• Simplified the drag modifiers, the preferences window, and the scripting interface.

• Can move the source folder to the trash after creating an image.

• Can choose the destination folder when converting.

• You can now specify preferences overrides using one sheet per image, rather than a
single modal dialog.

• You can now set the volume name and image name from the scripting interface.

• Added a returning immediately scripting parameter. This lets you control whether
the script waits for DropDMG to finish creating the image.

• You can now use tildes in paths when scripting DropDMG.

• Suggests localized image names, when possible, and omits hidden extensions, so that
you don’t end up with, e.g., a .app.dmg file.

• The license agreement editor is much more responsive.

• You can set the encoding from the DropDMG Status window’s contextual menu.

• Can now encode .dmg images with MacBinary.

• Updated the MacBinary encoder for compatibility with Apple’s JDK 1.4.1. (In the
latest JDK, Apple removed support for JDirect, which the old MacBinary encoder
relied upon.)

• Fixed bug where DropDMG couldn’t image a folder with more than 100 or so top-level
items.

• Worked around problem where some .dmg images created with Disk Copy could not
be converted to .img or .smi.

• Fixed license agreement assertion failure bug.

• DropDMG will no longer let you quit while an image operation is in progress.
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• The agreement editor window zooms to the width of the text field that Disk Copy will
use to display the agreement when the image is mounted.

• When you drag something over the DropDMG Status window, its instructional text
changes to tell you the meanings of the modifier keys.

• The DropDMG Status window is closable (if you register).

• License agreements remember their window positions across renames.

• The License Agreements window is printable.

• The DropDMG Status window zooms to a reasonable width instead of the whole
screen.

• The DropDMG Status window summary shows more of the current preferences.

• The progress bar is finer-grained.

• The key equivalent for Delete Selection is Command-Delete instead of Command-D.

• Better error messages.

• DropDMG is better about picking fresh names for its temporary files.

• The Registration window is smarter about ignoring whitespace and control characters
that can be introduced when pasting in a serial number.

2.0—October 23, 2002

• Converts dropped images to the format specified in the preferences when you hold
down Control-Shift.

• Hold down Option when dropping a folder or image to specify settings to be used for
that item (temporarily overriding the preferences).

• Makes self-mounting NDIF images (SMIs). This is the only kind of image that supports
license agreements on both 9 and X.

• Creates smaller zlib-compressed images when running on 10.2 and later. (The images
are still compatible with 10.1’s Disk Copy.)

• You can now choose to post-compress with BZip2 instead of GZip. BZip2 is slower
than GZip but creates smaller files.

• Improved the layout of the preferences window.

• Faster at copying files to the image when running on 10.2 and later.
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• Worked around 10.2 bug that caused errors when a file or folder name contained a
slash (as shown in the Finder).

• Worked around OS X bug that prevented copying files larger than about 1 GB.

• New application icon.

• Compiled with GCC 3.

• No longer calls thread-unsafe parts of Carbon from child threads.

• Prevents the user from making a read-write image with a license agreement, rather
than stopping midway through with an error message saying that this wasn’t possible.

• The status window no longer looks as though it will accept the drop when you try to
drop a .dmg file that doesn’t need metadata fixing.

• Changed File menu text and keyboard shortcuts to more closely match 10.2’s Disk
Copy.

• The about box and registration window now use the design first seen in SpamSieve.

• The log no longer uses the large system font under 10.2.

• Better error message if you try to image the startup volume.

• Fixed bug where images with license agreements contained duplicate styl resources.

1.7.3—August 17, 2002

• Fixed bug that could make DropDMG crash when you clicked the Include license
agreement checkbox.

• The spelling commands now have the standard keyboard equivalents.

• The Preferences. . . keyboard equivalent has been changed to Command-,.

1.7.2—August 15, 2002

• Removed spurious error message when changing the attributes of text in a license
agreement.

1.7.1—August 12, 2002

• The user interface no longer gets out of sync when you modify license agreements.

• Changes to the segment size take effect immediately; you no longer have to type Tab
or Return to commit them.

• The status window updates faster.
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1.7—August 12, 2002

• Added support for license agreements. License agreements support rich text and may
be localized.

• The image destination path is now stored abbreviated with a tilde, if possible. This
should help people who have multiple boot partitions.

• The log is printable.

• Finer-grained progress bar and status text.

• If adding the requisite filename extensions would make the requested image name longer
than the limit, DropDMG will now quietly truncate the name rather than stopping
with an error.

• NDIF images are now created with filenames of 31 characters or less, so that there
won’t be any name mangling when they’re viewed in Mac OS 9.

• DropDMG now truncates .dmg volume names to 62 characters and .img volume names
to 27.

• Fixed bug where DropDMG could deadlock after certain kinds of errors.

• Fixed bug where DropDMG sometimes didn’t detect filename collisions until after it
started making the image.

• Fixed bug where DropDMG would overwrite pre-existing .dmgpart files if the first
segment was not present and the newly created image happened to have the same
name.

• Renamed some File menu commands.

1.6—July 15, 2002

• Option to make images auto-open. When you mount an image, its window opens in
the Finder. Previously, there might have been no visual indication that the image had
mounted, depending on how the user’s Finder preferences were set.

• The status window has a contextual menu for quickly changing common preferences.

• You can optionally set the names of the image file and volume, instead of having them
based on the name of the folder.

• Documentation is now included in Apple Help (HTML) format as well as PDF.

• Contains a menu command for clearing the log.
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• No longer fails when copying files for which the user only has read privileges. Previ-
ously, DropDMG would copy the file and permissions and then report a permissions
error when it tried to set the catalog information of the copy, which wasn’t writable.

• The radio buttons for selecting where the image will be saved are no longer linked to
the image destination text field. That is, tabbing of the text field no longer affects the
radio button’s selection, making the preferences more friendly for keyboard navigators.

1.5—May 2, 2002

• Multi-threading—DropDMG can create more than one image at a time, and the inter-
face remains responsive.

• Can divide large images into multiple segments of fixed size.

• Creates uncompressed read-only images, which often compress better with GZip than
internally-compressed image files do.

• Creates read-write images.

• Encodes Mac OS 9 .img images with MacBinary so that they can be transferred on
the Internet.

• The status window displays a log that shows all the completed operations and errors.

• The status window now shows all the format options that are in effect.

• Faster copying of Mac metadata.

• Worked around Apple bug that sometimes caused errors when creating large images.

• Fixed bug where DropDMG mistakenly resolved symlinks when copying Mac metadata.
This had caused some metadata not to be copied, and also caused image creation to
fail if the user didn’t have write access to the original file.

• Fixed regression where DropDMG sometimes didn’t complain when the destination
folder was inside the source folder.

• Tries several times to eject images, rather than giving up immediately.

• More detailed reporting of file copy errors.

• More accurate reporting of what state the image creation process is in when errors
occur.

• Mailing list for version announcements has a Web interface.
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1.3.1—March 11, 2002

• You can now create images by dragging and dropping folders into the status window.

• The status window’s indication of the progress is more accurate.

• Fixed regression in which images couldn’t be created on non-boot volumes.

• Fixed regression in which images couldn’t be created in ~/Desktop if the destination
folder had never been manually set.

1.3—February 25, 2002

• You can now choose whether images are saved next to the source folder, or in a user-
defined folder.

• Volume images are now created in ~/Desktop by default (instead of /Volumes).

• Resolved problem in which DropDMG tried to replace invisible system files on the
image, if the source folder contained items with the same names.

• The format parameter is now optional when creating images with AppleScript.

• Notifies the system after fixing an image’s type and creator.

• Fixed bug in which DropDMG would report the wrong file as the cause of a copy error.

• The keyboard loop in the Preferences window should work again.

• The status window no longer flickers when the program first opens.

• The distribution is smaller, since the manual uses fewer images.

1.2.1—February 11, 2002

• Uses Carbon to preserve Finder info (e.g. the locked, stationery, and custom icon bits)
when copying files.

1.2—February 3, 2002

• All options are now available from the scripting interface.

• No longer requires Mac OS X’s optional “BSD Subsystem” installation.

• Optionally post-compresses DMGs with GZip.

• Fixes type and creator codes of DMGs.

• Preferences window is easier to use; now, enablement is only tied to the Image Format
radio buttons.

• Capitalizations now follow the Aqua Human Interface Guidelines.
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1.1—January 28, 2002

• Supports ADC and NDIF compression for compatibility with Mac OS 10.0.x and Mac
OS 9, respectively.

• Supports encrypted compressed images in the zlib and ADC formats.

• Optionally detects packages so that you end up with a mounted image containing the
package instead of a mounted image that the Finder thinks is a package.

• Copies locked files to images (instead of stopping with an access error).

• Images’ logical sizes are smaller; this should slightly reduce their physical sizes and
reduce mount times.

• Accepts drops of all file types (including packages); if DropDMG doesn’t know how to
handle a dropped file it will just ignore it.

• The Make Image From Folder. . . menu command lets you choose packages and
subfolders of packages (instead of just vanilla folders).

• Minor UI tweaks.

1.0—January 21, 2002

• First public release.

11 Legal Stuff

DropDMG

DropDMG and this manual are copyright c© 2002–2003 Michael Tsai11. All rights reserved.
Please distribute the unmodified DropDMG-2.1.dmg file on the Web, LANs, compilation

CD-ROMs, etc. Please do not charge for it (beyond a reasonable cost for media), or distribute
the contents of the image file in isolation.

This software is provided by the copyright holders and contributors “as is” and any
express or implied warranties, including, but not limited to, the implied warranties of mer-
chantability and fitness for a particular purpose are disclaimed. In no event shall the regents
or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequen-
tial damages (including, but not limited to, procurement of substitute goods or services; loss
of use, data, or profits; or business interruption) however caused and on any theory of lia-
bility, whether in contract, strict liability, or tort (including negligence or otherwise) arising
in any way out of the use of this software, even if advised of the possibility of such damage.

DropDMG is a trademark of Michael Tsai. Mac is a registered trademark of Apple
Computer. All other products mentioned are trademarks of their respective owners.

11mailto:mjt@c-command.com
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MacBinary Toolkit 2

The MacBinary III encoder is copyright c© 2003 Gregory L. Guerin. DropDMG uses it in
unmodified binary form under the terms of the Artistic License. Thanks, Greg! The original
source is available12.

PCRE

Regular expression support is provided by the PCRE13 library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

12http://www.amug.org/%7Eglguerin/sw/
13http://www.pcre.org
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